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Lab 3: Imaging Asteroids 
 

Finding Asteroids 
There are now more than 700,000 minor planets (asteroids, comets, and Kuiper Belt 
Objects) cataloged by the Minor Planet Center, and more are being added daily.  When 
an asteroid is first discovered, it is given a preliminary name consisting of the year of 
discovery, followed by a letter indicating the half-month of discovery (e.g. A for Jan 1-
15, B for Jan 16-31, etc., but skipping the letter I).  When more than one asteroid is 
discovered in a given half-month, it is given a second letter in sequence (i.e. 2006 CA, 
followed by 2006 CB).  When all letters through Z are exhausted, numbers are added (i.e. 
2006 CZ is followed by 2006 CA1, followed by 2006 CB1, etc.).  However, some letters 
and numbers are skipped, for reasons I do not understand.  Possibly this is because some 
“discoveries” were given a designation and then later found to be space junk, or for some 
other reason not a real asteroid.  The total number of asteroids discovered in the last half 
of January, 2017 (i.e. with designations starting with 2017 B) was 1360!  Most of these 
are very faint (greater than magnitude 17).  Once an asteroid has been observed many 
times over more than one orbit, it is given a permanent designation which is a sequential 
number followed by a name.  The name is one given by the discoverer, but must be 
agreed upon by the International Astronomy Union.  The first asteroid is 1 Ceres, the 
second is 2 Pallas, etc.  As of this time, there are more than 480,000 numbered asteroids, 
but only about 20,000 have names.  Some of the names are strange or whimsical.  Use the 
steps listed below to look up the names of the following asteroids and write them into 
your lab book: (2309, 2404, 3552, 3568, 4231). 
 
We are going to start with some bright and easy to find asteroids.  As a class we will 
observe one asteroid from among the first 100 numbered asteroids, and then you will 
each choose another from among the fainter ones (numbered above 1000—the higher the 
better).  Cartes du Ciel has a list of asteroids numbered below 5000—although it also has 
provision for downloaded the full list from the Minor Planet Center (MPC).  The 5000-
asteroid list has already been loaded and positions updated for February 2017.  To look 
up a particular asteroid,  

• Click on the “find” icon (looks like binoculars). 
• Select the Asteroid radio button 
• Type in the asteroid number and click “Filter->” for the official name 
• Click “Find” to center the asteroid in the display.  Note that the asteroid may be 

below the horizon. 
• Once you have one you like, you can re-find it by just typing the name in the 

search box next to the “find” icon. 
Cartes du Ciel does not necessarily plot asteroids.  If they are not displayed (as a tiny 
yellow dot with its name next to it), click the “Show Asteroids” icon (three dots).     
 
Once you have the asteroids plotted in Cartes du Ciel, click on a few that you want to 
observe and check their magnitudes.  For the asteroids numbered 1-100, try to find one 
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greater than magnitude 12.  For the asteroids numbered greater than 1000, try to find one 
greater than magnitude 15.  Anything fainter than 15 may be too faint for Newark skies. 

Taking the Data 
These instructions assume that you have successfully connected to the telescope and 
camera, the camera is at a stable temperature lower than -20 C, and that the telescope is 
focused well using a 4-5 magnitude star.  Once you have selected your asteroid, write 
down in your lab book its designation (number and name), and its listed visual or red 
magnitude.  You may find its J2000 coordinates useful to write down, also.  Point the 
telescope at its location and take an image in the Luminance filter to verify that you have 
the correct location.  Identify the stars in the field, and use Astrometry.net to verify that 
the telescope coordinates are the expected ones.  Write down the image center 
coordinates, focal length and orientation (position angle) that Astrometry.net gives, for 
use later in another program we will use: Astrometrica. 
 
Once you are satisfied that you are correctly pointed (you will probably be able to 
identify the asteroid, since these are quite bright), set up the image sequence to take a 
series of 3 Luminance-filter images of 20 s each, using the name of the asteroid, followed 
by a “_1” as your file name.  For example, if your asteroid is Arago, use Arago_1 as the 
name. Come back to the asteroid at least two more times in the next two hours or so, and 
take two more sets of images with the name Arago_2 and Arago_3. The image sets 
should be separated by about 20-45 min.  Others will be taking their images in the gaps 
between your images, so a certain amount of efficiency is required. 
 
When you are done with the data taking, you should have three image sets on your 
asteroid numbered greater than 1000.  We also want to calibrate these images.  As a class, 
we will take the necessary bias and dark frames, with the names Bias and Dark, as we did 
in lab 2.  We will also take our first flat frames. 

Flat Frames 
Whenever you wish to take nice deep-sky photographs, or when you want to do 
photometry (using the CCD data to determine accurate relative brightnesses), you will 
have to take a series of flat frames in each filter you are using for your data.  In this case, 
we will use only the Luminance filter, so we will take Luminance flat frames.  The basic 
idea is to measure the vignetting (brightness variations in the image due to partial 
blocking of the main mirror of the telescope), or correct for “dust donuts,” by pointing at 
an area of uniform brightness and taking images at an exposure that will give about 
20,000-40,000 counts in each pixel of the image.  You will be shown how to take a 
sequence of 10-20 such images, with the name of Flat, to make a nice, uniform 
illumination of the CCD.  Any non-uniformities that we see in the image are due to the 
vignetting in the telescope, or dust on the optics.  As a class, we will take our images at 
dusk before class or at the end of the night before closing up the telescope (there are 
several options which will be discussed in class).  Unlike the Bias and Dark frames, 
which are subtracted from the data, the data are divided by the (normalized) Flat frame.  
For example, say the brightest part of the Flat frame is at brightness 30,000, and the 
darkest part is at 27,000.  Then the Flat frame is first normalized (divided by 30,000) to 
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give 1 for the brightest part and 0.9 (27,000/30,000) for the darkest part.  Then the data 
are divided by the normalized flat, so that the brightest part of the data frame is divided 
by 1 (i.e. not changed) while the darkest part of the data frame is divided by 0.9 (i.e. 
boosted in brightness by 10%).  As the name implies, this flattens the data frame, making 
its sensitivity uniform. 

Analyzing the Data 
As a class, we will first do the calibration and create master frames.  To do this, we open 
the Process/Set Calibration… menu item in MaxIm DL, and select the directory where 
we stored our Bias, Dark and Flat frames.  The “Auto-Generate” button should then give 
us the correct list of frames of each type.  Once we are satisfied, we will click the 
“Replace with Masters” button to perform the analysis and create single master frames of 
each type (one each for Bias, Dark, and Flat).  Read in the Flat master frame and take a 
look at it.  You should see an overall pattern of a bright doughnut-like shape, with darker 
corners.  When applied as described above, this brightness pattern will be used to correct 
for brightness variations in the data images.  By using the “Replace with Masters” button, 
we converted our dozens of Bias, Dark, and Flat frames into three calibration frames that 
we will then upload to the Data Depository so that you can use them to calibrate your 
data. 
 
To process your data, you will first set the calibration to use the three master frames just 
created.  Then use Batch Save and Convert from the File menu in MaxIm DL to apply the 
calibration, and write your calibrated frames to another directory.  You will use these 
calibrated frames for all further analysis.  The first step is to combine the images for each 
of the three sequences on each asteroid.  We combine images to improve the signal to 
noise, and to allow us to throw out images that might have been affected by poorer than 
normal telescope tracking.  After combining, you should have three calibrated and 
combined images for each asteroid, taken at different times over 1 or 2 hours.  The stars 
will all be fixed, but the asteroid will have moved.  After combining, using the example 
above, you would have three images, Arago_1, Arago_2, and Arago_3.  Now read in all 
three of these and choose Align from the process menu.  Follow the procedure to align 
these images, using the middle one as the reference.  You can then view them as an 
animation if you wish (choose Animate… from the View menu) just to check that the 
alignment went well and that you can see the asteroid move.  If your asteroid is faint, you 
may not be able to find it, but Astrometrica can.  SAVE your three aligned images for 
each asteroid, using Save As… from the File menu, and be sure to select Size Format as 
16-bit Int.  It will probably be set to IEEE float, which is NOT a format that Astrometrica 
can read. 

Using Astrometrica for Astrometry and Photometry 
The last step is to read your images into Astrometrica for measuring the asteroid positions 
and brightness.  First, open Astrometrica and click the choice to delete the existing log 
file.  Then read all three images for a given asteroid—the times and dates should all be 
okay, so you can click OK to each.  Now select Moving Object Detection from the 
Astrometry menu.  The program will ask you for coordinates, so check that they are what 
they should be (the coordinates that you wrote down from Pinpoint when you were taking 
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data).  If they are not correct, either use the coordinates you wrote down from Cartes du 
Ciel, or if you did not record them, go back to Cartes du Ciel, set it for the correct date 
and time, and check the coordinates of your asteroid there. 
 
Once Astrometrica has the coordinates, it will do the usual attempt to solve for the star 
positions.  If it cannot, use manual mode and type the orientation angle from 
Astrometry.net, but with the opposite sign.  Also check the focal length.  After the usual 
effort, Astrometrica should get the solution and will then automatically detect moving 
objects.  It will probably identify 10-100 possible objects!  If your asteroid is bright 
enough, it will find it as the first moving object.  We will discuss how to use the moving 
object feature to designate and accept moving objects.  Once accepted, the information on 
the asteroid will be placed in a minor planet center (MPC) report.  You can list that by 
selecting “View MPC report file” from the File menu.  This report file can be sent 
directly to the minor planet center to be used in their database!  This information is 
actually of scientific interest.  In addition to the position, the brightness of the asteroid 
will also be listed.  Compare the magnitude you found with the predicted magnitude that 
you wrote down from Cartes du Ciel. 
 
Finally, choose View Log File from the File menu and write down the speed and position 
angle of the motion of the asteroid. Use the “Track and Stack” feature of Astrometrica to 
combine your three images into a single image that follows the asteroid and allows the 
stars to trail.  Save this image and include it in your report.  On the image, add text that 
indicates the asteroid name and number, the center (middle image) coordinates, the 
magnitude, the speed (in arcsec/minute), and direction of motion. 

Results 

Asteroid Distance and Orbital Radius 
The motion of asteroids is complicated, because both the Earth and the asteroid are 
moving in their orbits.  Therefore, any observation over a short period such as a couple of 
hours cannot give an accurate idea of the asteroid’s distance.  The asteroid may be near a 
stationary point, or even be in retrograde motion.  However, most of the lower numbered 
asteroids such as the ones you have imaged are in circular orbits in the asteroid belt.  In 
that case, we can use the speed of motion and the brightness to tell us something about 
the asteroid’s orbital distance and size.  We will do this exercise for the brighter asteroid, 
but if you wish you can repeat it for the fainter one as well.  The geometry of this 
situation is shown in Figure 2. 
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Figure 2: Geometry of Sun, Earth, and Asteroid, where the orbits are considered to be 
circular, and the distances are in astronomical units (AU).  The distance from Sun to 
Earth is 1 AU, the distance from Earth to the asteroid is d, and the distance from Sun to 
asteroid is r.   

 
The angle (as seen from Earth) between the Sun and the asteroid is SA, which we can 
measure.  The line of sight to the asteroid is along d, so the plane of the sky is 
perpendicular to this direction, as shown.  The orbital velocities of Earth and asteroid are 
ve and va, respectively, and the components of these velocities in the direction of the 
plane of the sky are ves and vas.  The asteroid appears to move in the sky with speed v = 
(vas – ves).  Now the speed of a circular orbit is just the distance around the orbit (2pr) 
divided by the period, P. Let’s use speed units of AU/yr, to save us some work.  Then the 
orbital speed is just v = 2pr/P, so ve = 2p (since r is 1 AU and P = 1 yr) and va = 2pr/P. 
where r is the distance from Sun to asteroid, and P is the orbital period of the asteroid in 
years.  But we know how periods depend on distance from the Sun for circular orbits 
(from Kepler’s Law of Periods), P2 = r3.  So va = 2pr/r3/2 = 2pr-1/2. 
 
Now what about the angles in the situation?  Because va is perpendicular to r, and vas is 
perpendicular to d (by definition), the angle between va and vas is the same as the Sun-
Earth angle SE.  Thus, vas = va cos SE.  Likewise, because ve is perpendicular to the Sun-
Earth line, and ves is perpendicular to d (by definition), the angle between ve and ves is 180 
- SA,  so ves = ve cos (180-SA) = -ve cos SA. 
 
The final velocity we want, then, is v = (vas – ves) = (va cos SE + ve cos SA).  
Unfortunately, we do not know the angle SE.  However, using the Law of Sines, we can 
replace it with an expression involving the angle we do know, SA, since 

r/sin SA = 1/sin SE 
so cos SE = (1 – sin2 SE)1/2 = (1 – sin2 SA/r2)1/2.  Substitute that into the above expression 
for v, and use the fact that ve = 2p and va = 2pr-1/2, to get: 
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v = 2p [(1/r – sin2 SA/r3 )1/2 + cos SA].   (1) 
This is the difference in velocities in the plane of the sky between Earth and the asteroid, 
in terms of the distance of the asteroid from the Sun, and the angle between the Sun and 
asteroid as seen from Earth.  What we measure, however, is not the velocity but only the 
angular velocity, call it vang, in arcsec/minute.  Now, given v in AU/yr, we can find vang in 
(arcsec/yr) by vang(“/yr) = [v (AU/yr)/d (AU)]*206265”/radian.  There are 365.25*24*60 
= 513,000 minutes in a year, so  

vang(“/min) = [v (AU/yr)/d (AU)]*206265/513000 = 0.4 v/d.  (2) 
 
Inserting v into this expression and solving for d, we end up with the remarkably simple 
relation for the distance to the asteroid: 

d = [0.8 p/ vang(“/min)] [(1/r – sin2 SA/r3 )1/2 + cos SA].   (3) 
 
The last thing to do is use the Law of Cosines to relate d and r in terms of SA: 

r = [1 + d2 – 2d cos SA]1/2    (4) 
Inserting (3) into (4) gives the final expression for orbital distance to the asteroid in terms 
of measurable quantities SA (angle between Sun and asteroid) and vang (angular speed of 
the asteroid in the plane of the sky, in arcsec/minute).  The problem is, doing that leaves 
us with a nasty function of r that we do not know how to solve.  However, we can simply 
try a range of distances r on the right side of (4) and the one that equals r on the left is the 
solution.  In other words, plot the function on the right side, and the function r = r, and 
where they cross is the solution.  I have written a Python program that does that, called 
AST_DIST.  You simply give it your measured values of vang and SA, and it prints the 
distance to the asteroid and the orbital radius of the asteroid. 
 
Run AST_DIST, using your values of vang and SA for the asteroid numbered less than 
100, and write down the returned values for r and d.  Compare them with the 
corresponding values given by Cartes du Ciel.  They should agree fairly closely, 
depending on how non-circular (eccentric) the asteroid orbit is.  Write down your values 
of r and d.  You will use them in the next section. 

Asteroid Albedo and Size 
Once we know the approximate distance to our asteroid, we can use the measured 
magnitude to determine the actual size of the asteroid.  You may think that, for a given 
distance, a bright asteroid would be a big one, and a dim one a small one.  That is true if 
they all reflect the same fraction of light (called the albedo).  However, they are not all 
the same.  Some are reflective, like ice or snow, while some are black as coal.  The 
following description is from “Astronomy & Astrophysics, 4th Edition” by Zeilik and 
Gregory1:  
 

The…solar [power] falling on an asteroid is 
(Lsun/4pD2) pR2 

where Lsun is the luminosity of the Sun, D is the distance from the Sun, and R is 
the radius of the asteroid.  A fraction A (the albedo) is reflected back into space.  

                                                
1 Copyright (1998), Saunders College Publishing, Harcourt Brace, New York, p133. 
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If the Earth is a distance d from the asteroid, the flux of reflected light at the 
Earth is 

Fvis = (Lsun/4pD2) pR2 (A/4pd 2).      (4) 
We can measure this flux and so determine the quantity R2A. The fraction of 
energy absorbed, 1 – A, heats up the asteroid and is re-emitted into space as 
infrared radiation.  We can observe this infrared flux at the Earth.  The ratio of 
visible to infrared flux is 

Fvis/FIR = A(1-A) 
From this measurement, we can determine A, and then use this value with the 
previous determination of R2A to calculate R. 

 
You can look up the albedo for many named asteroids at the Wikipedia web pages.  High 
numbers mean a reflective surface, while low numbers mean a dark surface.  Look up the 
albedo for our asteroid and write it down in your log book. 
 
You measured the flux of your asteroid by measuring the visual magnitude in 
Astrometrica, but how does flux relate to magnitude.  Recall that magnitudes only work 
as magnitude differences, which relate to flux ratios.  So a single magnitude does us no 
good.  We need to compare it with something.  Since it is the Sun that is providing the 
light by which we see the asteroid, let’s use the Sun as a comparison.  The basic equation 
is: 

m1 – m2 = 2.5 log F2/F1        (5) 
where m1, m2 are two magnitudes, and F1, F2 are the two corresponding fluxes.  Flux is 
the luminosity divided by the area of a sphere centered at the star (or body) and of a 
radius equal to the distance to the object, L/4pd2.  We will use m1 = m as the apparent 
magnitude of the asteroid, and m2 = -26.72 as the apparent magnitude of the Sun.  The 
flux of the Sun at Earth is F2 = Lsun/4prEarth2, where rEarth = 1 AU.   The flux of the 
asteroid, F1, is just the value given in equation (4). 
 
Substituting all of this into equation (5), we have 

m – (–26.72) = 2.5 log [(r2/r2Earth)(4d2/R2A)]. 
All you need to do, then, is insert your measured value of m, your calculated values of d 
and r (in AU), the value rEarth = 1 (in AU), and the albedo, A, that you got from the albedo 
table.  Solve this equation for the radius of the asteroid, R.  Compare your calculated 
value with the true size of your asteroid, if you can find it on Wikipedia.  (Try entering 
the number and name of your asteroid in the search, e.g. “24 Themis”.) 

Conclusion 
You have made some rather simple measurements of asteroids—their position, their 
speed and direction of motion, their magnitude.  Using these few facts, plus the asteroid’s 
albedo, together with some geometrical relations and Kepler’s Law, you were able to 
estimate the distance to the asteroid, its distance from the Sun, and even a measure of its 
size.  This is the remarkable thing about the universe—it follows mathematical 
relationships and other physical laws that allow us to learn a lot about it from just a few 
careful measurements—things that we could never have imagined that we could know 
from just a few feeble photons. 
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Bulletized Synopsis 

Purpose: Measure the position of main-belt asteroids and estimate 
distance and size 

• Take three sets of images separated by 30-45 minutes over 1-2 hours, of two 
asteroids (one numbered less than 100, and one numbered greater than 1000). 

• Combine the images within each set, then align with the other sets to create three 
aligned images for each asteroid. 

• Use the images to measure the position, motion and brightness (magnitude) of the 
asteroid in Astrometrica. 

• Use your measurements to estimate the distance and size of the brighter asteroid. 


